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Introduction
As discussed in Module 7 of the Land-use Finance Tool, Sankey diagrams
can be useful visualisation products to provide an overall picture of the
land-use finance mapping results. Several tools and software can be used
to create Sankey diagrams based on the data collected during the study.
Module 7 offers a comparison between three tools that have been used
to create Sankey diagrams in the context of finance mapping studies.
This annex provides detailed guidelines on the use of two of these tools:
RAWGraphs¹,² and e!Sankey³.
The choice of tool will mostly depend on the complexity of the dataset and
your objectives. We recommend using RAWGraphs for small datasets with
few categorical dimensions. The tool allows you to generate small and
well-designed Sankey diagrams in only a few clicks by uploading a cleaned
dataset in Excel. However, it is ill-suited to illustrate layers of information,
such as the distinction among green, grey or brown flows (see 3.1 Steps
to develop a detailed typology of land-use activities). On the other hand,
e!Sankey is a more flexible tool that allows you to tailor a Sankey diagram
according to the study objectives, and reflect various dimensions and layers
of information.

¹ http://RAWGraphs.io/gallery/
² ‘How to make an alluvial diagram’ by RAWGraphs Team. Licensed under CC BY-NC-SA 4.0.
Accessed on 28 May 2018, from https://RAWGraphs.io/learning/how-to-make-an-alluvial-diagram/
³ https://www.ifu.com/en/e-sankey/
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For the purpose of these guidelines, we highlight the distinction between horizontal
and vertical dimensions.
Horizontal dimensions in a land-use finance landscape are the categories
through which finance flows through the finance life cycle.
Vertical dimensions, called nodes in these guidelines (as per the terminology
used in Sankey software), are the different actors in the horizontal dimension.

Figure 1 illustrates this distinction. Dimensions are split among sources/intermediaries,
instruments, and disbursement channels and uses. Nodes gather for example
government revenues, bilateral donors and agencies, bilateral development finance
institutions, etc. Additionally, this example shows green (aligned) and grey (conditionallyaligned) flows.

Nodes

Dimensions

Figure 1: Sankey
diagram of the Vietnam
case study indicating
different dimensions
and nodes
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Figure 2, which was created with RAWGraphs, features the following Dimensions :
sources of finance/intermediaries, financial instrument, disbursement channel and
use; and Nodes : government budgets, climate funds, agencies, public financial
institutions, grants, low-cost project debt, etc.
Figure 2: Sankey
diagram example
indicating different
dimensions and
nodes using
RAWGraphs

A Sankey diagram is created using quantitative input from either a dataset or data
extracted from it (through pivot tables for instance). The preparation of data input that
precedes the design process is essential. The following section explains how to prepare
the data to use it in a Sankey tool.
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1. Preparatory steps: cleaning
the database and creating
pivot tables
1.1 Cleaning the database
After gathering and consolidating all the data in the Excel template (see Template 10), it
is important to clean it before moving to data analysis, as you do not always control the
format and type of data imported from external data sources.
Figures 3 and 4 give examples of datasets that need to be cleaned and completed before
data can be used to create a Sankey diagram.

Figure 3: Example of
the Vietnam case study
dataset before cleaning
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Figure 4: Example
of the global finance
analysis dataset
before cleaning
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Cleaning your data ensures that values are comparable and are correctly read/
recognised by tools. Before you start cleaning the data, make sure you create a backup
of the original data in a separate Excel file. Below is a list of 11 simple actions to clean
your data⁴:
1. Remove extra spaces: extra spaces before or after a word or value in a cell need
to be removed to remain consistent
2. Select and treat all blank cells: if there is no value (text or number) in a cell,
remove the entire row
3. Convert numbers stored as text into numbers
4. Write numbers with decimal points ‘.’ not ‘,’
5. Convert financial values to the preferred currency (EUR, USD, etc.)
6. Convert numbers to millions, billions or trillions, as preferred
7. Ensure all text is stored as text
8. Remove duplicate rows by using ‘Remove Duplicates’
9. Check the spelling: clean up misspelled words to ensure a consistent use
of categories and nodes
10. Use upper case for the first letter of each text entry
11. Remove all font styles and colours for all values except for the column titles
Once the data has been cleaned, the columns and rows needed to create the Sankey
can be copied and pasted to another Excel tab to simplify the next steps. You only need
to cluster columns corresponding to the dimensions that you want to illustrate in the
Sankey diagram and their respective quantitative values (see the final result in Figure 5).

⁴ https://support.office.com/en-us/article/top-ten-ways-to-clean-your-data-2844b620-677c-47a7-ac3ec2e157d1db19
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Figure 5: Example
of a cleaned dataset

1.2 Creating pivot tables
When information is consolidated in one spreadsheet, different pivot tables need to
be created to provide the values to be imported into the software. Pivot tables allow
to calculate the values for the flows from one dimension to the following dimension .
In the example below, the first pivot table created is between the sources of finance
and financial instruments dimensions.
These pivot tables can be created in the ‘Sankey Pivot Tables’ tab in Template 10, by
clicking on the button ‘PivotTable’ in the ‘Insert’ menu. In this tab, you have previously
defined steps as placeholders for their individual pivot tables (see Figure 6 below).
Figure 6: Creating
a Pivot Table
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Next, the prepared data has to be selected in the ‘Database Structure’ tab.
Figure 7: Selecting
the data

After selecting your data range and creating the pivot table, the ‘PivotTable Field List’
panel appears where you can select the exact data columns you want to include in your
specific pivot table. Pivot Table 1 should contain finance that flows from dimension ‘Sources
of finance’ to dimension ‘Financial instrument’ (see Figure 8).
Figure 8: Pivot
Table 1 data
selection
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This pivot 1 provides many insights:
• It summarises how much each source of finance contributed: ‘government budgets’
are the largest source of finance, and provided a total of USD 2 049 million of climatealigned finance.
• It shows how much was spent, in total, on each instrument: USD 3 186 million was
spent on grants, by far the most important instrument in this example.
• It quantifies the financial flows between sources of finance and financial instruments:
out of the USD 2 049 million contributed by ‘government budgets,’ USD 1 855 million
were issued as grants, and USD 194 million as low-cost project debt.
• It shows the distribution of financial instruments used by each source: ‘climate funds’
have invested roughly equal amounts in ‘grants’ and ‘low-cost project debt,’ while
‘agencies’ have only used grant financing.
Table 1: Pivot 1
linking sources of
finance to financial
instruments

The data selected to create pivot 1 can be visualised in a Sankey diagram, which is
more intuitive than the table (see Figure 9).
Figure 9: Sankey
diagram linking
sources of finance
to financial
instruments
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To complete the climate finance cycle, more pivots are needed. Pivot 2 shows how
much climate-aligned finance was actually delivered by each instrument and to which
disbursement channel. Finally, pivot 3 quantifies the uses of climate-aligned finance
for disbursement channel.
Table 2: Pivot 2
relating financial
instruments to
disbursement
channels

Figure 10: Sankey
diagram relating
financial instruments
to disbursement
channels

Table 3: Pivot 3
relating channels
to end uses
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Figure 11: Sankey
diagram relating
disbursement
channels to uses

Illustrating green vs grey finance
To create a Sankey diagram in which financial flows can be segregated among green,
grey or brown finance, it is crucial that the related dataset provides enough detail to
filter these categories. To do so, an extra layer is added in the pivot tables to filter
flows. Figure 12 provides an example. In this case, the category ‘Is the activity helping
to reduce pressure on/protect forests?’ segregates ‘Yes’ (green) flows from ‘Unknown’
(grey) flows.
Figure 12: Applying
an extra filter to the
dataset, for example
grey vs green
finance
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case study example
featuring a green vs
grey finance filter in
the pivot table
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2. Creating a Sankey diagram
using RAWGraphs

The graphics in this section will show how to create a Sankey diagram using the
RAWGraphs website: http://app.RAWGraphs.io. The Sankey example is based on
a CPI climate finance study.
The datasheet can easily be pasted or dragged and dropped into the box on the
webpage, or uploaded, as shown in Figures 14 and 15.

Figure 14: Paste
the data from your
spreadsheet
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Figure 15: Or
upload the
complete dataset

Once the data is successfully recognised, you can choose the type of diagram you
want to create. Select ‘Alluvial diagram’, also known as Sankey diagram.
Next, the different dimensions that need to be visualised in the Sankey diagram can be
mapped. The dimensions from the left column can be dragged into the ‘Steps’ box. You
must do so in a sequential manner to ensure that the dimensions of the Sankey diagram
start on the left with sources of finance and ends on the right with uses . The values are
dragged to the ‘Size’ box, which will give the flows the corresponding volume/thickness.
Note that only data that is recognised as numbers can be dragged into ‘Size’, hence the
importance to clean the datasheet.
Figure 16: Map
the dimensions to
be visualised in
the final Sankey
diagram

Now the tool generates the Sankey diagram. Users can adjust the width and height
of the Sankey diagram, as well as the width of the nodes.
Figure 17: Format
the size of the
Sankey created
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Additionally, you can change the colour of the different flows according to your preference.
The final result can subsequently be downloaded as a .jpeg or .png file. It is also available
as an html code, which allows you to embed it in a webpage.
Figure 18: Sankey
diagram showing
financial flows from
sources, through
instruments,
disbursement
channels, to uses

When using RAWGraphs to create a Sankey diagram, the data is simply uploaded into the
RAWGraphs website. The values influence the volume/thickness of the financial flows.
However, the tool itself will not show the value nor the currency on the Sankey diagram.
Therefore, if you would like to create a more detailed diagram (see Figure 19 below),
you need to perform some extra actions before the datasheet can be uploaded into
RAWGraphs.
Figure 19: Sankey
diagram showing
financial flows from
sources, through
instruments,
disbursement
channels, to uses
with values and
currency

If you want the numbers to appear in the Sankey diagram, they need to be added
manually into the dataset. You need to complete the text of the nodes in the Excel sheet
with the exact value of the total financial flow. For example, for the flow that moves
from node Government budgets under dimension sources of finance to the dimension
financial instruments , pivot 1 indicated the value of USDm 2 049. While the total flow
for node Grant under dimension financial instruments amounts to USDm 3 186 USDm.
The data in the datasheet can easily be filtered by dimension and node, and the value
can be quickly added into the text line.
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Figure 20: Adding
values to the
Sankey diagram
nodes

This action then needs to be repeated for every node.
Figure 21: Updated
dataset to add
values to Sankey
diagram text

When all nodes in all dimensions have been given their exact value, the updated
datasheet (see Figure 21) can be uploaded into RAWGraphs and a Sankey diagram can
be created by repeating the previous steps on how to make a Sankey with RAWGraphs.
More information is available at http://app.RAWGraphs.io
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3. Creating a Sankey diagram
using e!Sankey

This section will guide you in creating a Sankey diagram with the e!Sankey software using
data from the Vietnam case study as example (EFI and CIEM, 2018).
e!Sankey is a software that you need to download on your computer. A free trial version is
available, but a licence needs to be purchased for further use (see Module 7 for software
characteristics).

Figure 22: Sankey
diagram of the Vietnam
case study created
with e!sankey
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3.1 e!Sankey basics
After installing and opening e!Sankey, we recommend you watch the tutorial videos (in
English) on the e!Sankey YouTube channe⁵,⁶. The videos are two-three minutes each
and demonstrate the most important functions of the tool.
e!Sankey also features a detailed manual⁷ (in English) that describes the main steps to
create a land-use finance Sankey diagram.
In the e!Sankey software, the main working area has several panels:
1. Drawing Area: where the Sankey diagrams are drawn. Several diagrams can be
opened simultaneously.
2. Properties: allows to edit the properties of the network element marked in the
drawing area.
3. Entries: lists the material or finance that are added as flows in the arrows of the
Sankey diagram.
4. Controller: allows to scale the flows in the diagram and edit unit types.
Figure 23: e!Sankey
working area

4

2

1

3

⁵ https://www.ifu.com/en/e-sankey/support/#c1090
⁶ https://www.youtube.com/channel/UCFFAWqNTTi2u8-mIgXY9GZg/
⁷ https://www.ifu.com/fileadmin/user_upload/esankey/content/eSankey_User_Manual_en.pdf
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Important functionalities
Figure 24:
e!Sankey toolbar

7

1

8

2

3

4
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Some of the main functionalities accessible from the working area toolbar include:
1. Create a diagram file: click on the button ‘New Document’ in the toolbar.
2. Open a diagram file: click on the button ‘Open Document’ in the toolbar.
3. Save a diagram file: click on the button ‘Save Document’ in the toolbar, or
choose ‘Save As…’ from the file menu. e!Sankey diagram files feature the
extension ‘.sankey’.
4. Undo: to undo (revert) an action that has been done in the software, click on the
button ‘Undo’ in the main toolbar or use the menu entry ‘Undo’ in the ‘Edit’ menu.
5. Redo: to redo (revert undo) an action that has been undone, click on the button
‘Redo’ or use the menu entry ‘Redo’ in the ‘Edit’ menu.
6. Edit mode: click on the ‘Mouse’ button to select and edit elements.
7. Export a diagram file: click on the ‘Export…’ command in the ‘File’ menu, and
select a file type. The following file types are available: PNG, JPG, GIF, BMP and
EMF. The ‘Choose Export Quality’ dialogue allows you to adjust the quality and
resolution of images in order to produce high-resolution image export files.
8. User interface language: the user interface language of e!Sankey can be English,
German, French, Spanish or Portuguese. Access the ‘Options’ dialogue via the
‘Edit’ menu. In the ‘General’ tab choose the new language. You will have to restart
the application for the change to take effect.
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3.2 Creating a Sankey diagram
To create a Sankey diagram there are three basic steps:
1. Drawing nodes (referred to as ‘processes’ in the tool)
2. Drawing arrows between the nodes
3. Adding flows and values into the arrows

Step 1. Drawing nodes
To draw a node, click on the button ‘Process’ in the toolbar. Then click in the drawing
area where you wish to place the process node and draw by moving the cursor.
Figure 25: Draw
a node

Node Properties
By clicking on a process node in the diagram, the properties panel will show the ‘Process
Property’ panel.
Figure 26: Process
Property panel to
edit a node
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By default, a process node is drawn as a square or rectangle. But you can change
the shape to a rounded rectangle, or ellipse/circle. You can also change its colour.
The ‘Arrows’ part in the process property dialogue relates to the way arrows are
connected to the process (see below in the section ‘Arrow routing and connectivity’).

Naming process nodes
To change the name of a node from ‘Process’ to its corresponding node name, for
example ‘National Budget’, select the node label and change the text of the node label
in the properties panel. In this panel, you can also adapt the font and colour of the node
label.
Figure 27: Editing
the node’s name

Next, you move the node label inside the process node by dragging the small blue
point into the centre of the node. By dragging the small grey corners of the label, you
can adjust its size.
Figure 28: Node
name changed
and dragged to the
centre of the node
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Changing node size and shape
The size of the node can be changed by dragging its corners. To align its size and shape,
‘Ctrl’-click on all the nodes that need to be changed. Then right-click on the process node
you want to choose as template and click ‘Set Size to this Element’ (see Figure 29 below).
Figure 29: Format
several nodes
simultaneously

Aligning nodes or setting them at same distance
To align several nodes, select them all and go to the process node to which the other
nodes should be aligned to. Right-click ‘Align to this Element’. From the dropdown menu,
select one of the alignment possibilities (see Figure 29 above).
To set nodes at a same distance from each other, select them all and then right-click ‘Set
at Same Distance’ (see Figure 29 above).

Figure 30: End result
Step 1 - drawing all
the nodes
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Step 2. Draw an arrow
Once all the nodes are created and designed, you can move to drawing the arrows
between them by clicking on the ‘Arrow’ button in the toolbar.
Move the cursor to the centre of the process node (start node). The node will become
dark grey and the cursor symbol turns into a hand. Left-click drag to the destination node.
Figure 31:
Drawing an arrow

Figure 32:
Dragging the arrow
from the ‘National
Budget’ node

Figure 33:
Dragging the arrow
to the ‘National
Government’ node

The arrow at that stage is empty (‘<No Flows>’ is indicated). The arrow shows two red
points where it connects to the nodes, and two yellow marker points where the curve
of the arrow can be adjusted.
Figure 34: A newly
drawn arrow shows
‘No flows’ and the
different arrow
points
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Arrow connectivity
The way an arrow is connected to a process node depends on the connectivity setting
in the process property dialogue. The default setting is ‘Free’, meaning the connection
direction is not restricted to a certain side, but depends on the angle of an imaginary line
between process nodes. If you want to force the arrow to connect to a specific side of a
process box, set the connectivity in the process property dialogue to one of the following
options: Left to right, Right to left, Top to bottom, or Bottom to top.
Figure 35:
Setting the arrow
connectivity to
determine how
the arrow flows
between the nodes

Arrow properties
When clicking on an arrow line, the Arrow Properties box will appear on the left of
the screen.
Figure 36: Arrow
Properties box to
edit an arrow
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The options ‘Arrow Head’ and ‘Arrow Tail’ can be used to individually turn on or off the
base (tail) or the head of each arrow. The figures below show examples of arrows with
tails and head turned on and off.
Figure 37: Arrow
with head and tail
turned on

Figure 38: Arrow
with head and tail
turned off

The option ‘Rounded’ gives arrows that are drawn with rounded bends. The default
setting is 30 degrees.
Figure 39: Rounded
arrow with a 30°
curve

Note: in the section ‘Extra Step: Arrow layout’, more information is given on how
to edit the layout of the arrow.
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of Step 2 - drawing all
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Step 3. Add a flow to an arrow
After having created all the arrow lines between nodes based on the information from
the pivot tables, you now have to define ‘what’ flows through the arrows from one node
to the next. Flows can be money, material, products, people, and so forth. In the case of a
land-use finance Sankey, flows represent financial flows (volume of finance), which will be
proportional to the arrow’s width.

Creating entries
To create a new entry or type of flow, click on ‘Add Entry’ in the ‘Entries’ panel at the
bottom of the screen. Change the ‘New Entry’ placeholder with ‘Green finance’ or ‘Grey
finance’ (or other flow categories) and select the unit type of this flow. Different types of
flows can be given different colours.
Figure 41: Creating
a new flow

Figure 42:
Selecting a unit
type and colour
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Adding flows to an arrow
Once all entries (types of flows) have been created, select one entry (for example ‘green
finance’) from the entries list and drag it directly onto the arrow line in the Sankey
diagram. Based on the information from the pivot tables (see below on how to connect
flows to quantitative data) a specific arrow line between two nodes is selected and
allocated the corresponding flow type.
Figure 43: Dragging
a flow type to an
arrow

The Arrow Property dialogue box in the ‘Property’ panel on the left will appear and
mentions for example the entry ‘Green finance’ in the flow list. You can manually enter
the quantity of the specific flow in the ‘Quantity’ column; or the corresponding value can
also be copied and pasted directly from the pivot table into the tool (see more detailed
explanation in the section ‘Extra – Links to Excel’).
Figure 44: Adding
the quantity of the
arrow
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After entering the flow quantity, the width of the arrow line between the two nodes should
now be proportional to the value, in our example: VND 1598.88 of ‘green finance’ that
flows from the node ‘National Budget’ to the node ‘National Government’.
Figure 45: Example
of an arrow with a
green finance flow

A flow can be removed from an arrow line by selecting it and then clicking on the button
‘Delete Flow’.
Figure 46:
Deleting a flow
from an arrow

Creating unit types for the entry
It is important to note that for each entry (type of flow) in the ‘Entries’ panel, a unit type
has to be selected. In e!Sankey, ‘Mass’ and ‘Energy’ are pre-defined and activated unit
types. But for financial flows, the unit type ‘Money’ needs to be created for the first time.
Unit types are created in the ‘Edit Unit Types’ dialogue box by clicking the ‘Edit Unit
Types’ button in the ‘Controller’ panel.
Figure 47: Creating
a new unit type

Annex II - Sankey guidelines

30

Click on the ‘+’ icon at the bottom of Unit Types. Add the name ‘Money’ for the new unit
type in the field ‘Name’ and define a number format to display quantities in this unit type,
for example ‘0.00’.
• 0.00: the number is shown with exactly two decimal places. The value will be rounded
to two decimal places or filled with zeros if there are less. This is the common number
format for currencies.
• 0,0: use a comma after the first zero to display thousand separators (for example, five
million is shown as ‘5,000,000’).
Figure 48: Adding
a new unit type
‘Money’

You can also define a colour pallet for this unit type. In the Vietnam case study, we added
the colours green and grey as we wanted to illustrate these two types of financial flows
(see Figure 49).
Figure 49: Defining
the colour set for
the new Unit type
‘Money’
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For each unit type defined in the ‘Edit Unit Types’ dialogue box, at least a basic unit
must be defined. For land-use finance Sankey, the basic unit for ‘Money’ is the chosen
currency. To change an existing basic unit, just click on the first line of the units table in
the ‘Name’ column and edit the unit name there. Note: changing a basic unit does not
convert any flow quantities.
Figure 50: Defining
a new unit for the
unit type ‘Money’

Now that flow types and values have been attributed to all arrows, you need to go
through some further steps to improve the layout of the Sankey diagram (see Figure 51).

Figure 51: End result
Step 3 - Adding flows
and values to the
arrows
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Extra Step. Arrow Layout
Thickness of the flow
The thickness of the arrows and their flows can be adjusted by moving the pixel bar of
the Unit Type ‘Money’ in the ‘Controller’ panel. In the Vietnam case, we have applied 93
pixels to increase the flow thickness.
Figure 52: Adjust
the thickness of the
flow by changing
the px value of the
Unit type ‘Money’

Other arrow properties
To further adapt the layout of the arrows, select all the arrows and make the changes
in the ‘Arrows Property’ dialogue.
Figure 53: Arrow
Properties panel
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By using the options ‘Gradient from Source’ and/or ‘Gradient to Destination’ you can
replace the default colour setting for a Sankey arrow. As a result, the arrow’s colour will
gradually turn from one colour to another. The start colour is defined by the colour of the
node and has to be set individually for each node in the ‘Process Properties’ panel (see
Figures 54 and 55).
Figure 54: Gradient
from Source/
to Destination coloured arrow

Figure 55: Gradient
from Source/
to Destination coloured node
and arrow

If you want to add a border line to an arrow, use ‘Draw Border’. Click on ‘Select Colour’ to
set the border line’s colour, width and style. As mentioned above, in a Sankey diagram,
the arrows’ widths are proportional to the magnitude of the flows. However, some flows
are very thin compared to other flows and barely visible in the Sankey diagram. This
setting can be very useful if you still want to highlight this flow in the Sankey, as the
thickness of the flow can be adjusted slightly by adding a fine border in the same colour.
Figure 56 illustrates this setting in the Vietnam case study.
Figure 56: Barely
visible financial flow
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Figure 57: How to
draw a border on
an arrow

Figure 58:
Selecting the
colour of the
arrow’s border

Figure 59: Arrow
with a border
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Note: settings can be applied to multiple arrows. Right-click on ‘Use As Default’
from the context menu of the arrow to ‘lock’ the settings for the arrows you will
draw next.

Arrow labels
The options in the ‘Label’ section of the arrow properties enables you to either show
or hide arrow labels.
Figure 60: To
display an arrow
label

The arrow label is automatically created when a flow and a flow quantity are entered into
the arrow. By default, it is placed near the middle of the arrow, but it can be positioned
where it fits best and rotated. The specific information shown in the arrow label can be
selected individually. To edit a label, click on an arrow label and the properties dialogue
box will appear in the ‘property’ panel on the left of the screen.
Figure 61: Arrow
content label
property panel
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The default display option for the arrow label is set to ‘Values’, so that the flow quantities
are shown. The flow content label consists of the flow’s name, value and unit. The values
are created automatically and cannot be edited directly, but you can individually select
name, value and unit. Also, the ‘Alignment’, ‘Font’ and ‘Colour’ of the flow content label
can be adapted in this dialogue box.
In the Vietnam case, we selected to show only the ‘Value’ and ‘Unit’.
Figure 62: Different
content types of
arrow labels

Arrow routing
The routing of an arrow between two nodes is done automatically when two nodes are
connected with an arrow line. As mentioned earlier, this line has certain arrow points (red
and yellow points) that determine the route and they become visible when the arrow is
clicked. More points can be added if necessary, to change the route of the arrow.
Figure 63:
Changing the route
of an arrow by
dragging its arrow
points

Crossing arrows
When there are many arrows crossing each other, you have to decide which should run
on top of the other. Click on the arrow that is supposed to be on the top layer and select
‘Bring to Front’ from the context menu. Alternatively, click on the arrow underneath and
choose ‘Send Backward.’ You may have to repeat these actions several times to move
an arrow backward several layers. The commands for changing the element layer ‘Bring
Forward’, ‘Send Backward’, ‘Bring to Front’ and ‘Send to Back’ are also available on the
main toolbar.

Note: this is useful to bring smaller flows on the top/front layer of the Sankey
diagram and increase their visibility.
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Figure 64:
Adjusting the
arrow crossings by
changing their layer

Other diagram elements
Titles or text
To add additional text to a Sankey diagram, click on the ‘Add Text’ button on the toolbar.
Alternatively, choose the command ‘Text’ from the ‘Draw’ menu. Then click on the
position in the drawing area where the text element should be placed. You can also
edit the alignment, font, and font size and colour in the text properties for one or more
selected text element.
First, give a title to your Sankey and add another textbox indicating the currency and
values used in the flows. Second, you need to create the different dimension titles.
Figure 65: Adding
a textbox to the
Sankey diagram

Figure 66: Added
title, textbox
indicating the
currency and titles
for the dimensions
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Legend
A legend should be added in the diagram to identify the different flows in the Sankey
diagram by their colour (green or grey finance). To add a legend, click on ‘Show Legend’
in the ‘Draw’ menu.
Figure 67: How to
add a legend

You can change the position of the legend by dragging it. The ‘Legend Property’ dialogue
in the ‘Properties’ panel allows you to adapt the legend via two tabs. The ‘Graphical’ tab
allows you to adjust lines, background colour, font and other graphical items of the legend.
The ‘Content’ tab enables you to adjust the content and the order of the legend entries.
Figure 68: Legend
Property dialogue
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Other shapes
Additional graphical elements are available to improve a Sankey diagram layout. These
are: rectangle, rounded rectangle, ellipse and line. These items are available in the
‘Shapes’ menu in the toolbar.
Figure 69: To insert
lines, rectangles,
etc.

You can also add images to the Sankey diagram. In the Vietnam case study, we added
the logos of the partners (see Figure 70).
Figure 70: To insert
images

Extra
Editing multiple elements
For editing the properties of multiple elements, select the elements you want to edit.
Then choose the element type from the dropdown list ‘Edit Type’. The property settings
you choose will be applied to all selected elements.
Figure 71: How
to edit multiple
elements
simultaneously
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Grid
To properly align process nodes, it is helpful to turn on the grid. The button can be found
in the editor toolbar.
Figure 72: Applying
the grid

Templates
With e!Sankey, diagrams can be saved as templates for creating new diagrams in the
same styles, including Entries, Unit Types, Process and arrow properties, and Graphical
elements (shapes, text elements and legend).
To store a diagram file as template file, use the ‘Save As…’ command from the ‘File’ menu.
In the ‘Standard file save’ dialogue choose ‘e!Sankey Template (.santem)’ from the file
type dropdown menu.
To create a new diagram file using a specific template, either click on the entry in the list
in the ‘New Diagram’ section on the start page or choose the template by its description
from the dropdown menu of the ‘New’ command in the ‘File’ menu.

Link to Excel
The Excel Live Link dynamically links the quantity value for a flow in an existing diagram
file in e!Sankey with a cell in an Excel spreadsheet. When the user changes the value in
the cell of the Excel sheet, the value in the Sankey diagram will be automatically updated
and the arrow redrawn accordingly, so that its magnitude represents the new value.
A Live Link is created by copying a cell value in Excel (‘Ctrl-C’) and pasting it (‘Ctrl-V’) in
the ‘Quantity’ field in the ‘Arrow properties’ panel. To have this panel visible, the arrow
must be selected, before the cell content is pasted. The link has been established when a
green arrow appears in the ‘LL’ field in the panel (see Figure 73).
Figure 73: Live Link
to Excel
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Resources
RAW Graphs website: http://app.RAWGraphs.io/
RAW Graphs learning resources: https://RAWGraphs.io/learning/
RAW Graphs basic tutorial: https://www.youtube.com/watch?v=2TtYlty-M5g
e!Sankey website: https://www.ifu.com/en/e-sankey/support/#c1090
e!Sankey training videos Youtube: https://www.youtube.com/channel/
UCFFAWqNTTi2u8-mIgXY9GZg/
e!Sankey manual (English): https://www.ifu.com/fileadmin/user_upload/esankey/
content/eSankey_User_Manual_en.pdf

